Batching Applications to Hiring Managers
· Open your Internet Explorer browser

· In the address bar, type 69.225.112.10 and hit enter

· Click on Login in the upper right corner
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· Type in your user name and password for the Online Hiring Center (OHC)

· Select the “Online Hiring Center – Departments” radio button

· Click Login – your welcome screen will appear and show all of your open requisitions
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· Click on “My List”
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· Find the Req. # for the applications you would like to view.  In this example, Jane Instructor needs to see applications for the Admin Mgr position.  (The “My List” feature in the OHC is the list of Eligible applicants the HR Manager has referred to the hiring manager/ supervisor)  
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· From the Referred Lists screen, click on the Print link under the “Applications” column.

A screen similar to this is what you will see after you click on Print under the “Applications” column.
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· Next, click on “Download All Applications”   - OR -
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· If you only want to download select application(s), select the names of the applicants in the column on the left hand side of the page that you want to download.  (In this example, Jane only wants Elvis Pressley’s applications.)

· Click on “Download Selected Applications”

A new window should appear that looks similar to this one:
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If the screen above appeared, skip page 5 and continue on to page 6

If your screen displays a message that looks like this, you will need to set your pop-up blocker to allow you to view pages from this site. 
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INSTRUCTIONS FOR SETTING YOUR POP-UP BLOCKER
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1. Right click on pop-up blocker message in tool bar and a drop down menu will be displayed

2. Click “Always allow Pop-ups from This Site” 

3. A new message window may display that says “Allow pop-ups from this site?”  
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4. If this window is displayed, Click “Yes”

5. Click on “Return to My List” and follow the same steps to download the application(s) until a new separate window appears

After you have downloaded the applications, you will see a screen similar to this:
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In order to save this document to send as an attachment in an email to your hiring managers, you will need to do the following:

· Click on File from the menu bar at the top left corner of the page
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· If you have it as an option, click on Edit with Microsoft Word  (If you don’t see this option, skip to page 8)

This will open up the application in MS Word if you have that option.  

[image: image13.png]2 appprintview] 2] - Microsoft Word

Fle | Et Vew Inert Fomat Tods Tabe Mindow Heb - x
O hew. Curkn »
& Open. ko
4 e =
TS
E sove Cirl+s. —
Save s
@ save as Web page. STATE OF SOUTH CAROLINA Received: 6/22/07 3:02 PM
State Career Center1401 Senate Street For Official Use Only: —
& search Columbia, SaLith Carolina 29201 QUAL:
(803) 734-9080 e Ep—
hittp:/jwww.iobs.sc.00v #D0Experience
tieh Page Previen sohanng
= Pressley, Elvis sootheri___
Page Setup 00046 ADMIN, MANAGER
[& print Preview PERSONAL INFORMATION
& o e SOCTAL SECURITY NUMBER:
sendTo ,
9210
Properties TERNATE PHONE: EMAIL ADDRESS:
LEH,..Oriine Hiing Center - View op X
IVER'S LICENSE NUMBER: LEGAL RIGHT TO WORK IN THE UNITED STATES?
2 EHNEOGOewing sppicaton n nsight eOves eOno
3G Apris Tech SupportITURN OFF .
PREFERENCES
4. Progressive Disc Plcy 06,26 e S OUWILLING TG RELOCATE?
et ®Oves” ®ONo_eOMaybe

G FOR?

TYPES OF WORK YOU WILL ACCEPT:

SHIFTS YOU WILL ACCEPT:

EDUCATION

DATES:
From:_To

NAME:

LOCATION: (City, State)

DID YOU GRADUATE?

DEGREE RECEIVED:

MAIOR:

UNITS COMPLETED:

OEEX!

oo~ Iy | Aoshapes N % C1O B ol

iring Cen.

ppprint:




· After the applications are opened in MS Word, click on File in the upper left-hand corner

· Select Save As…
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· Type a file name next to the “File Name” field.  You may want to include the Req #, the Job Title, and/or the Hiring Manager’s in the file name.

· In the “Save as Type” field, select Word Document from the drop down menu

· Click on the Save button

· Next, open your email and create a new message to the hiring manager/supervisor.  Attach the file you just created to the email for the hiring manager/supervisor to review.    

If you were not able to open the file in MS Word, you have 3 options:

1. Save the file as an HTML file (web page) and send it to the hiring manager/supervisor to open in Internet Explorer

2. Print the applications and deliver them to the hiring manager/supervisor 

3. Copy and paste all the applications into MS Word or similar software application

OPTION 1: SAVE APPLICATIONS AS AN HTML FILE
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· Click File in the upper left corner and select “Save As” from the drop down menu

[image: image16.png]Save Web Page

@ Deskion

(Civy Documents
3y Computer

vy Network laces
(EelSouth Information

5P RS0 Reference Guide
(200 Search suff

(E2amy eMusic

|5 Wedding Photos for Kathryn
[E2Wine Country Info

sest By WP Hep

|Req 0046 Admin Mar Apps for Hiing Manager ¥
Vieb Page, conplte ("t Fim) ]

[Unicode (UTF5) L





· In the Save Web Page box that appears, type in a file name next to the “File Name” field.

· In the “Save as Type” field, select Web Page, complete (*.htm; *.html) from the drop down menu

· Click on the Save button

· Next, open your email and create a new message to the hiring manager/supervisor.  Attach the file you just created to the email for the hiring manager/supervisor to review.   

OPTION 2: PRINT THE DOWNLOADED APPLICATIONS

[image: image17.png]rosoft Internet Explorer

Edt Vew Favorites Tools Hep
New »
Open, culso

STATE OF SOUTH CAROLINA EMPLOYMENT APPLICATION

Edit with Microsoft Word for Windows 'STATE OF SOUTH CAROLINA Received: 6/22/07 3:02 PM
State Career Center1401 Senate Street For Official Use Only:
Save s Columbia, South Carolina 29201 QUAL___
(803) 734-0080 DNQ: ______ F
Page Setup. http://www.jobs. jov DExperience
i, cotse Traning
print revien Pressley, Elvis Sother
00046 ADMIN. MANAGER
send 4 PERSONAL INFORMATION
Import and Export. 'SOCIAL SECURITY NUMBER:
NA
ropertes 5
WorkOffne ) 1o
Close ALTERNATE PHONE: EMAIL ADDRESS:
DRIVER'S LICENSE: DRIVER'S LICENSE NUMBER: LEGAL RIGHT TO WORK IN THE UNITED STATES?
Cves Cves o
PREFERENCES
PREFERRED SALARY: ARE YOU WILLING TO RELOCATE?

Oves ONo OMaybe

WHAT TYPE OF JOB ARE YOU LOOKING FOR?

TYPES OF WORK YOU WILL ACCEPT:

SHIFTS YOU WILL ACCEPT:

EDUCATION

DATES:
From: _To

NAME:

LOCATION: (City, State)

DID YOU GRADUATE?

DEGREE RECEIVED:

MAJOR: UNITS COMPLETED:
[ WORK EXPERTENCE
DATES: EMPLOYER: POSITION TITLE:
From: _To

ADDRESS: (Street, City, State, Zip Code)

"COMPANY URL:

PHONE NUMBER:

‘SUPERVISOR:

HOURS PER WEEK:

SALARY:

Changes paper, headers and footers, rientation, and margins fo ths page.

Online Hiing Center

MAY WE CONTACT THIS EMPLOYER?





· Click File in the upper left corner and select “Print” from the drop down menu 

· Select the printer you want to print to and click Print
· If you print a paper copy of the application(s) to give to the hiring manager/supervisor, the application(s) will include answers to all statewide questions as well as any supplemental questions 

· If any of those questions are confidential, the hiring manager/supervisor will not see the applicant’s responses

· Each application will begin on a new page

OPTION 3:  COPY AND PASTE DOWNLOADED APPLICATIONS INTO MS WORD
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· Click on the “Edit” tab in the upper left corner
· Click Select All
[image: image19.png]N Internet Explorer

Fie 20 View Favorites Toos Help

copy culsc

[STATE OF SOUTH CAROLINA EMPLOYMENT APPLICATION]

Select Al colsa

Find (on This Page)... Col+F

[STATE OF SOUTH CAROLINA
Career Center1401 Senal

Pressiey, Elvis
00046 ADMIN: MANAGER

Oraining
Cother:

IPEi

N

INFORMATION

CIAL SECURITY NUMBER:

DRIVER'S LICENSE

RIVE

PREFERRED SALARY:

WHAT TYPE OF JOB ARE YOU LOOKING FOR?

TYPES OF WORK YOU WILL ACCEPT:

SHIFTS YOU WILL ACCEPT:

DUCATION

DATES:
From: To
LOCATION: (City, S

DID YOU GRADUATE?

DEGREE RECEIVED:

UNITS COMPLETED:

[ IWORK EXPERIENCE

DATES:
From: To

ADDRESS:

COMPANY URL: PHONE NUMBER:

SUPERVISOR:

HOURS PER WEEK:

MAY WE CONTACT THIS EMPLOYER?

Contains edit commands,

Online Hiing





· Click on the “Edit” tab again with all the fields highlighted in the downloaded file
· Select “Copy”
· Open MS Word 
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· Click on the “Edit” tab in the upper left corner
· Select “Paste” and the downloaded applications will be added to a new document
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· Click on the “File” tab in the upper left corner
· Select “Save As” 
· Type a file name next to the “File Name” field.  You may want to include the Req #, the Job Title, and/or the Hiring Manager’s in the file name.

· In the “Save as Type” field, select Word Document from the drop down menu

· Click on the Save button.

· Next, open your email and create a new message to the hiring manager/supervisor.  Attach the file you just created to the email for the hiring manager/supervisor to review.    

· If you copy and paste a large number (20 or more) of downloaded applications into MS Word, you may have problems if your computer does not have enough memory to store the copied applications in memory before it can paste it into MS Word.  Each application will vary in length, depending on the number of statewide questions and supplemental questions.  Some applications will be 5 or more pages when pasted into MS Word.  

· Consider this option only if the other 2 options do not work.
Getting Applications from Insight-HR to Hiring Managers(Basic Step by Step)
· Log in to training.neogov.com
· Click on “Log In” in the upper right hand corner of screen

· Type in Username and Password

· Select the “Insight-Human Resources” radio button

· Click “Log-In”

· Under “Candidate Track” at the top of the screen, select “Active”

· Locate your job posting title

· Click “Print” under the Applications column

· Fill in “Start Date” and “End Date” (These are the dates when the applications were received.  Allows you to pull only applications that you need)

· Select “Download Type”

· Select “Source”

· Select “Processing Type”

· Click on “Download Now”

· If you need to download all applications, click on “Download All Applications”
· If you need to download specific applications, click on the check box beside the applicants’ name, and then click on “Download Selected Applications”

· If you selected “PDF Batch” as the “Processing Type,” you will receive an email from NEOGOV to inform you that your batch is ready

· Go back to “Candidate Track” and “Active”

· Locate the posting

· Click on the Batch link

· Print applications or save the applications as a HTML or PDF file in your computer to send as an attachment through email

Print and Download Submitted Applications from HR(Detailed)

 

1.   Access MyHR

2.   From the ‘CandidateTrack’ pull-down menu, select ‘CandidateTrack’

3.   The CandidateTrack search screen displays

4.   Locate the recruitment you wish to print

·         To Search by Job Number:
o        Select the ‘Job Number’ radio button

o        Enter the Job Number in the grey text box

o        Click on the upper ‘Search Button’

·         To Search by Job Title:
o        Select the ‘Job Title’ radio button

o        Enter the Job Title in the grey text box

o        Click on the upper ‘Search Button’

·         To Search by Recruiter Name:
o        Select the recruiter name from the ‘Search by Recruiter’ drop down box

o        Click on the upper ‘Search Button’

** Note:  You may further refine your search by choosing both a recruiter name and a specific Job Number or Job Title

·         To Search by Applicant SSN/Name:
o        Enter the applicant’s SSN in the ‘SSN’ textbox

o        Enter the applicant’s first name and/or last name in the ‘First Name’, ‘Last Name’ text boxes

o        Click on the lower ‘Search Button’

·         To Search by Application Submitted Date Range:
o        Enter the ‘from’ date in the ‘Date 1’ text box

o        Enter the ‘to’ date in the ‘Date 2’ text box

o        Click on the lower ‘Search Button’

** NOTE:  You may further refine your search by entering both an applicant name as well as entering a date range

 

[image: image23.jpg]FARCT) Iy J00 Pasting Thie, Coce or'

208 Namber [————— [— o ermbar xS0 S

2ob Tl e iy S e ntred v 55

R .

sewen

P
T e T —
[T m— S m—

soweh |





 

5.   Click on the corresponding ‘Print’ link for the recruitment
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6.   Enter in the appropriate download information:

· Date Range – Date range applications were submitted

· Download Type – 
· Download Applications Only – Download applications, non-confidential agency-wide supplemental questions, and job-specific supplemental questions

· Download Applications And Resumes – Download applications, non-confidential agency-wide supplemental questions, job-specific supplemental questions, and resume information

· Download Confidential Report – Download applicant demographic information, confidential agency-wide supplemental questions, and job-specific supplemental questions

· Source – 

· Both – Download applications received online and on paper

· Online – Download applications received online only

· Paper – Download applications received on paper only

· Processing Type –
· Browser Real-Time – downloads applications in a PDF file immediately.  This option is recommended for printing less than 25 applications at a time, and when the document headers/footers are not necessary.  The selected applications display in a browser pop-up window, and can be printed directly from the web browser.  

· PDF Batch – downloads applications in a PDF file while you do other work and sends an Email notification when the batch process is complete.  This option is recommended if you are printing more than 25 applications at a time.  The selected applications will be converted to a PDF document which is accessible through the ‘Batch’ link on the ‘Candidate Track’ page.  When this option is selected, the user receives an email notification when the PDF file is ready.  The PDF file can then be saved to your computer and printed.
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7.   Click on the ‘Download Now’ button

8.   The applications received within the defined date range will display

9.   To navigate through the applications:

· Click on the applicant’s name you wish to view

· Click on the ‘Next’ or ‘Previous’ links to navigate by one application
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10.   To print the applications, download the applications into an Adobe Acrobat (.PDF) file:

· To download all applications listed

o        Click on the ‘Download All Applications’ link

· To download a subset of applications

o        Select the checkbox to the left of the applicant names

o        Click on the ‘Download Selected Applications’ button

11.   For Browser Real-Time processing:

· Selected applications will be rendered to a pop-up browser window in a printer-friendly format.  If you do not see a new browser window, try minimizing all other open windows.  Also make sure that you do not have any pop-up blocker software enabled.

· To print the applications form the browser printer window, click File | Print from the menu.

12.   For PDF Batch processing:

·           A message is displayed indicating that you will be notified when the PDF file has been created.  The message includes a ‘Return to CandidateTrack’ link that returns you to the ‘Open Recruitments’ page of the CandidateTrack menu:
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·           An email notification is sent once the batch process is completed.  When you return to the ‘Open Recruitments’ page, the ‘Batch’ link will be highlighted:
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·           Click on the ‘Batch’ link to display the Batch Report:
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·           To view the .PDF applications online
o        Click on the ‘View’ link

· To save the .PDF applications to disk

o        Click on the ‘Save’ link

o        A pop-up message will display

o        Click the ‘Save’ button

o        Select the folder to save the file into

o        Click on the ‘Save’ button

13.   To print the .PDF applications, click on the [image: image30.png]
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Congratulations!  You have successfully printed Submitted Applications.
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